Contents

1 WHY USE VISUALBASIC?. . .....civeiiiinanennenansl

Why Use Visual Basic. .. ..o ovvi i viii e i i e e 1
Is This Book For You? ........c.oiiiiiiinniivnnnnenn, 2
HowtoUse ThisBook ........... .o, 2
New Featuresin Version 4 .........cocoiiviieian, 2
What Computer You Need to Run Visual Basic ............ 3
Conventions . . ..o vv it e i e e 4
Running Visual Basic ... ....coiiviiiiii i, 4
Starting Visual Basic..........coiviiiiii i, 4
Before you Start.... .......ciiitiiiiii it 6
The Visual Basic Design Screen.............covvvinnnn 6

The FOrm . ... it e i i et i 7

The Toolbox . ......cv ittt i i 8

The Control Properties Window. ..................... 9

The Project Window . . .. ...... ot 9

The Visual Basic Menu Bar and Toolbar................ 9
Event-Driven Software. . . .. ....ovviiii i, 10
Outline of the Add Program .. .........oviivneinnennn 10
Creatinga New Project . . . ...... ..o, 11
Defining the User Interface . . ...........ovvvinn, 12
Movingand Scaling. ........... oo, 12
The Properties Window. . . . ... oo vviiiii i, 13
Changing Captions . .. ..o, 13
Writingthe Code . ... viviiiii ittt 14
Running the Program . . . ....... . .iiiiiiiiie ., 15
Using Properties. . . ....covit ittt i 16
Enabled and Name Properties . . .. ....ovvviinn .. 17
Control Values . . ..o vi ittt iiii e, 17
Controlling Form Properties ... ..........coivviinnn. 18

2 HOW PROJECTS AREORGANISED ......ccoveveseee. 20

Introduction. ... i vttt e it it e e e 20
The File Menu ... oo ittt ittt it i e e et iine s eanenen 20
Application Files. . . .. .o o v i it i e 21
FRM FileS . .o v vttt et e ittt ie s i eneaneannn 21
BAS Files ..o vv ittt et ettt e 21
VBXand OCX Files. . ...t iniiii it iiiiienenenn. 22
FRX FIles .. i i ittt ittt et tiitennanennnen 23
Creating and Saving Modules ............... ... 0L, 24
The Autoload File. . .. ... it it i it i it i e, 24

Bibliografische Informationen E H
) digitalisiert durch 1
http://d-nb.info/946955271 BLI '|'


http://d-nb.info/946955271

vi Contents

3 THE TOOLBARAND MENU .....ciieienancanananses 25

Introduction ......... 0.t i i i i 25
The Toolbar. . ......cvirii i it 25
Project and File Management . .. ...............couu.. 26
Displaying Windows . ..........c.cviiiiiiniinneann. 26
Running and Debugging Applications. . ................ 26
TheMenu....... .ottt i, 27
The Print Dialog Box .. .....ooviiin i, 27
The Edit MenU. . . oottt ivii ittt ii i it e inneenan 28
Finding and Replacing Text . ...........oiviviinnn, 28
Image Priority . ..o v ittt i it iiiie e 29
The Tools Menu. . ......oiiiiiiiiiiiininnneann. 29
The View Menu. .. ....oiiiiniiin e nannns 32

Introduction ...... ...ttt ittt 34
General Procedures ............ooiiiiiiiiiiiiian, 34
Event Procedures........... oo vt iiiiiiiniinnnnn 35
The Scope of Event and General Procedures . ............ 35
Using Event Procedures . . . .......coiiiiiininirnnns 36
Making a New General Procedure. .................... 37
Passing Arguments. ... ..o vit ittt e 37
Function Procedures ............coiviiivinernnnnnn. 38
Naming Conventions . ........ovviiiiiiiniennn. 38
] 8 38

Using DLLS .. .vtitiiinin it in i enennnnns 39

Declaringa DLL . ... i iiviii i ii i ieeienenenn 39

Callinga DLL. ....oiitinininiie i enennennns 39

5 CONTROLS. ......oiviieirnnnessnsnnssascasesss 40

Introduction . .....tiiinn ittt e et 40
The Toolbox Appearance . .........cocvevuvuvnunnnnn. 40
Common Toolbox Controls . .......covvviverenunnnn. 41
Command Buttons. . .. .covi ittt i i it iee e enannns 42
Labels .. ..o i i i i 43
Text Boxes. . ...oviiiiiienennnn. et et 43
Text Boxesand Passwords . ......ovv it viinnnnennnn. 44
Captions and Hot Keys. . . . .. cviviineinnninvnnnn, 44
Frames ... ..ottt it i i i e e e e e 44
Check BOXES &« v v v iiienies e ennnnns e 45
Option Buttons .........cotiiiiiinininnnnnnanennn 45
Scroll Bars. . . .vo v iii i e e e 46
List BoXes . .o i vttt i i i e e . 46



Contents vii

The Sorted Property .. .....civinviinnnenennnns 47
Combo BOXES . .o vttt i i e e 48
The Simple Combo Box..............cvvvvinennnn, 48
The Drop-down Combo Box .......... ... 49
The Drop-down Combo List. . .. . .oovvvviiinnnnnn. 49
The Timer Control ........ ... i, 49
Selecting Controls. ... ... ov ittt i i 50
Setting Propertiesof Groups . . . . .....coivii i 50
Custom Controls. . ... oo vt iii et i 50
The CommonDialog Control . ............... .. ..., 50
The Slider Control ..........covt i iiniinnnnn, 54
The StatusBar Control. . ............cciiiiiiiiinnnn. 54
6 THE INSURANCE QUOTE FORM...... Cerererenaaans 56
Introduction. . ... ..o i e 56
Design of the Quote Screen. . .........oovvviunvnn, 56
Using Options Buttons .. ......covviieinnnennenns 57
Creating Check BoXes . .. ..o vii i it ini s 57
Creating Combo and List Boxes. . . ....covvevenennn, 57
Running the Program . ... ......oiiiiiiininnnnnnn. 58
Initialising the List and Combo Box. . . ........c.vvvuenn. 58
TabIndex and TabStop .. .......coiiiiiiiinevnnnnnn 59
7 DIALOGBOXES ... civvviinnnrentannnnnss ceareeas 60
Introduction. . ...t e 60
Creatinga Message BoX. . .. ... coviii i iiiiv s 60
The Message Box Function . ..............coviniun, 60
The Message Box Statement. . .. . ... vvvevnrnnnrneennn 61
Using Messages BoXeS. .. ... vvviiiiiiniiiinnuneennss 61
Message Box Text. ... .o viiiinninininnnnneensn, 63
MsgBox Icoms. . ..ttt i e 64
Changing MsgBox Headers . ...........c.covvuenununn. 64
MsgBox Buttons . . .....oov i 65
Getting Button Input. . ... ...l e 66
TheInput Box Function . ........coiviuniennneeennn. 66
Specifying Default Text. .. .......cviviinninnenennnns 67
8 OPERATORS AND VARIABLES .....civtvnrennronnen 68
Introduction. . ... .ot i e i e 68
Data TYPes. ..o ittt et iiiie e e et innatsaanan 68
Rangeof Data Types. . .....oovivviinnnnnnennnnenn. 69
Declaring Variables. . . ........oovitiiiiiii i, 69
Static Variables. . ........ .. i it 70

Variables Scope . ........iiiiiiiii i 70



viii Contents
Arithmetic Operations. . ...........oiiiiiin., 71
Integer Division . ... ..o v ittt 71
The Mod Operator . .. ...ooivvi i e ennnns 71

The Comparison Operators. . . .....oovuivivivuenenesen 71
String Concatenation . ... .. viiviii i 72
The Logical Operators . ........oevvevrvunennennnnss 72
The And Operator . ... oo vt iviiin i ennnenens 72
The EQv Operator ... ...vcov v iinnneennnneses 73
The Imp Operator ... ..ot iviiiii it ennnnnnns 73
The OrOperator . ......cvvviiiiinieensannanes 74
The Xor Operator .........c.vireiiiininnennnacannn 74
The Not Operator. . .. oo iiiiiiniiinnrnnnenennenns 75
9 CONTROLLING PROGRAM FLOW........ ceseensae .. 76
Introduction .. .. ..ottt i e e 76
Types of Program Control ........... . ovvvviennan.. 76
The If...Then...Else Statement . . .. .......cvvvvvinnnn.. 76
Nested Ifs . ....covviniii it enan 77
TheElseIfClause ... .....cviitiiiiininninennnns 78
The Select Case Structure. . ... v oo vvvvvinn e ivnnenn.. 78
The Switch Function . ....... ..o, 79
The GoTo Statement . ...........coiiueinirennneennns 80
10 LOOPING CONSTRUCTS ......coovvvnivenennnn ceeess 81
Introduction .. ... vttt i i 81
Types of Looping Constructions . . . ......vovvevvnnnnn 81
The Do..WhileClause . . .......covviiniinin . 81
The Do.Until Clause. . . ..o v viinninnnnneenns 82
Exit Do Statement ... ....... ..ot iiinnnnnnn 83
The While..Wend Clause . . ............coovviae. 84
The For..Next Construct . ........ccvviinneennnnnens 84
Terminating For Loops. . . . ... .o, 85
EXit FOr. . o v ittt i i ittt 85
11 USING DATA STRUCTURES ......ceiiiviniennnnnns 87
Introduction ....... ..t i i 87
AITays. . ot i e e e e 87
Declaring Arrays. . .. .o vveiivvnninnnneesnnann. 87
One-Dimensional AITays. ... ..ovuvvvninneennnnnens 87
Multi-Dimensional Arrays. . .......ccoovvineennennnn 88
Re-dimensioning Arrays . .. ....oviiiiiiiiiiien e 88
Multi Dimensional Arrays. . ........ ...t 89
User-Defined Data Types . . ..o viviniennnnnennnennn 90

The Erase Statement. . .« oo v vt vt e rtvernoenonoenas 90



Contents ix

12

13

14

15

MENUS .. ittt iiiiiiiiitieeesnrenassesanasenns 92
Introduction. . ......ovtii ittt e 92
UsingMenu Bars . .......coiiiiiiiiiiiiininann.. 92
Amendingthe Menu.............. ... .. ..ot 94
Short-cut Keys . ....oovviiniiiii ittt 94
Enabling and Disabling Controls . ..................... 96
Menu Properties. . ...ooviii i 96
MDI APPLICATIONS ... . iitiiiiiiintienncnnnnns 97
Introduction. . ... . it i e 97
Creating an MDI Application. . .......... ... ... . oo, 97
Arranging Forms . ....... . oottt i 98
The Start-up Form . ........viiiii i, 98
Modal and Non-Modal Forms . . .............c.ovuu... 99
Loading and Unloading Forms ...............covouu... 99
The Hide Method .. ....... ..., 99
GRID CONTROL . ....iiittiievenosnrrnennsnnnnas 100
Introduction. ...t i i e 100
Installing the Grid Control ............... ... ... ..., 100
Creatinga Grid. .. ... ..o iii ittt 101
Grid Properties. . . .. vovii i e e 102
Writingtothe Grid. . ... .........ciiiiiinna... .. 102
Selecting Cells. . ..., 103
Adding and Removing Rows . .. ......ovviini i unn 104
ColWidth and RowWidth Properties .................. 104
Aligning Text .. ... .ottt 104
Scroll Bars . ..o vt s e 105
Adding Textto Grids ........ ... v, 105
Confusing Rowand Rows . . ......ovviinnnnenn.. 106
Editing Cell Contents .........coviiievnnnnnnnnnn, 106
CREATING GRAPHICS . ... iiviiiiiiiitiinnnnnanss 107
Introduction. ......... i i e 107
Useof Graphics .....coiviiiini it i, 107
The Co-ordinate System . .......... .. oiiiniinnnnn 108
TheImage Control . ......... ..o iiiiiiiinnneen, 109
The Stretch Property. .......coviiiiniiiini i, 109
Clipboard Images . . .......covtiiiiiiiiininnenn, 110
The PictureBox Control. . ........ovvviiinnenn.ns 110
The AutoSize Property . .........ccvtiiiiinvnennnn. 110
The Image and Picture Box Controls . .. ............... 110

Adding a Picture at Run-Time. . ..............o0onn.. 111



X Contents
Using Graphics Methods . .......... ... .o, 111
Controlling Individual Pixels ............. ... ... ..., 112
Graphical Controls. .. .. ... vii i it i 112
TheLineControl . ........ ... o i, 113

Properties of the Line Control. . ............. ... ... 113
The Shape Control........... .ot 113
Properties of the Shape Control. .............. ... ... 114
The Fill Style Property . .. ....viiiiiiiiiinennnnnn 114
Drawing Lines...... ... .o it iiiieinnnn 115
Drawing BoXes. . . ... v v v vie ittt naaann 116
Drawing Circles. .. .. ovviiiinii i nrennennenes 116
Drawing EIlipses ... .....vviiiiiiiniinninnennanns 117
Changing Units . . ....ovviiiiii it iiiieiniennannn 119
Using Colotrs .. ..o viin ittt i ininenena 119
The QBColor Function .. ......v.vevevenesennnenns 119
The RGBFUNCHON + . v v vvv i viviiiiinnneenannnnas 120
Assigning Colours Directly . ............ ... .o 120

16 DISPLAYING AND PRINTING...... ceseons cracnnns 122
Introduction ... e 122
Message Boxes, Text Boxes and Labels . ................ 122
Controlling Fonts and Font Characteristics . ............. 123
Using the Print Method . .. ......... ... . i, 123
Controlling Print Position. . . . ......vviiin i, 124
Controlling Number Format. ...............c v, 125
Custom Formats . ..........00vitiiiiinerinnennnns 126
Displaying Datesand Times . . ... .....covivviunnnns.. 127
WritingtoaPrinter............ ... i, 128
The Printer Object. . . . ..o v iii it iiii i 128
The PrintForm Method. . .. ....... ..o i, 129

17 MOUSE AND KEYBOARD EVENTS............ov0t 130
Introduction .. ....coviitt ittt e i 130
MouseEvents ......... .. iiieiiiiiineerrennans 130
Mouse Event Arguments. . . .. .. ..o it i i i 130
The Click Events ......vvv it iiiiniiennnnens 131
The MouseDown, MouseUp Events. .. ................. 132
The Button Argument .. .........covevenneennonnesens 132
The Shift, Ctrl and Alt Arguments. . ............ovuv... 132
Dragging and Dropping . .. ..o v v iii i i i 132
TheDragMethod. ... ..o ittt i, 133
The Draglcon Property. . ....coiiiiiiieninennnenan, 133
The DragOver Event. . . ..o o vviii i ininnen., 134

Keyboard Events ... ....coiiiiniiniiiinin e, 134



Contents xi

18

19

20

The KeyPress Event ...........coviiiiiiiinnnnnn. 134
The KeyDown, KeyUp Events .........covvvuuvnneann 135
OBJECT LINKING AND EMBEDDING (OLE) .......... 136
Introduction. ........ .o it e 136
Using OLE . . .. .. i it iae e aas 136
Linking and Embedding ............. ..o 137
The OLEControl .......cvvitviiiinninnevnnennenns 137
The OLE Pop-Up Menu. . ..o v vvi i iniinnirnennns 139
Using Paste Special . . . .. ..ot ivii it 139
Creating OLE Objects at Run-Time . .................. 140
OLE Update Options Property...........cocvvuvninvnn. 141
OLE AutoActivate Property...........covveeuveen.n. 141
OLE Verbs . . ..ottt ittt i i i in e 142
The AutoVerbMenu Property. . ........... ..o, 142
The Verb Property .......... oo, 143
The ObjectVerbsCount Properties . ................... 144
The Updated Event...........covtiiiiiinnnenrennenn 144
USINGFILES. ... .cciiitiinnnncnnarsnsssnsanssns 145
Introduction. . .....coiiiii it i e 145
Supported File Types ......... .o, 145
OpeningaPFile ..........viiiiiiiiiiiiniinenns 145
The FreeFile Function. ... ......ccoviviinnnennnenns 146
File Errors .. ..o ittt it 146
Closing Files. . . .....oov it 146
Reading Files .. .. ..ottt 147
Reading ASCIT Files .. ........ooiiiiinnnnnnnnnennn 147
Writing ASCIT Files. .. ......oiiniiiii it iinn, 147
Copying and Deleting Files . . ............covuviunnn. 148
Random Access Files. . . ....... ..ot 148
Using Random Access Files. ........................ 148
Binary Files ........ ... i 149
The Seek Statement. . . . .....oviiiii ity 149
Finding Files. . . ..... ..ottt 149
The FileListBOX. .« oo v v it e i it i e eiiiieiinennennn 150
The FileName Property...........ooiviiiunnnnnn. ., 150
Linking the Controls. . ......... ... cooiiiiivnnnn. 151
DATABASES .........cvvutnn crecaerenaanasensas 152
Introduction. . .......ov i e 152
Using Databases . . ........coviiiiniininnennnnn.. 152
Database Jargon . . ... ittt i i 152

CreatingaDatabase ........... ..o, 153



Contents

xii
Specifying Fields . .........c.oiiiiiiiiiiiie., 154
AddinganIndex ........ovvriiuiiiiiniiieiiaa 156
AddingData . ......co vttt i e e 157
The DataControl. ......ovvivi it iniaennnn, 158
Connecting the Data Control ............... .. .. ... 159
Viewing the Database. ... ......... . ..oiiiiiiiinn, 159
Bound Properties. .. ... . i i i i i 159
Properties for Data-Aware Controls. . . ................. 160
The DataChanged Property. .. ......... v, 160
The Traffic Sign Program. ... .. .o v e i i e vennnnn 161
Duplicating the Data Control ............. ... oiuinn 161
Adding and Deleting Records . . .. ........ ..o il 161
DeletingaRecord ........ .. i i, 162
Adding a New FieldtoaTable.................... ... 163
AddingaNew Table. . ......... ... oo i, 163
The Data Form Designer ............... ... ...t 163

21 EXAMPLES. .. it iiiiireieentensnasessanannss 166

Creating a Simple Project. . . ........ . ciiii i, 166
Creatinga Large Form .. ... ... i 167
Controlling Control Properties . .. .......vvvvvinvennn, 167
File Delete Program ... ......coiviiinnnnneeerronans 168
Finance COMPANY . .. v vvviinnnnninnresonenennnnnas 169
Zoo Database. .. .....iiiiiii it i e e 169
Changing Text Styles . . ....... ... i, 170
MDI Viewer. .. ..ottt it i e inaen e 171
Creatingand Using Grids. . .. ....... .. cvinnn, 172
Deleting Grid ROWS .. ..o v in ittt e i e ennennn 173
Importing Graphics .. ...... .. ..o i ... 174
Drawing PiCharts . ........... .. oo, 175
Printingtoa Picture Box . ........... ... ... ..o L. 176
Printing Tabular Data. . . ............ .. ... ... ...... 177
Printing at a Specific Location Using Format. . ........... 178
The Scribble Program. . ..................... ... ... 178
Using Navigation Keys................ciiiiunnn.. 179
File Handling. . .......... ... o i, 179
Christmas Present Database .. ...............c.00uvu.. 181

INDEX . ..., ciiiiiiiiiiiiieatsnconssnsnnsenes. 183



